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BAB 1  

PENDAHULUAN 

 

1.1 Konsep Dasar Sistem Informasi Geografis (SIG) 

Sistem Informasi Geografis sesungguhnya mempunyai arti yang sangat luas dan sukar 

untuk didefinisikan secara tepat. Beberapa ahli telah mencoba mendefinisikan dari sudut 

pandangnya masing-masing sehingga muncul beberapa istilah tentang Sistem Informasi 

Geografis. Sistem Informasi Geografis (SIG) adalah suatu sistem perangkat yang dapat 

melakukan pengumpulan, penyempurnaan, pengambilan kembali, transformasi dan visualisasi 

dari data spasial bumi untuk kebutuhan tertentu (Burrough, P.A., 1986). 

Menurut Aronoff (1989) secara umum Sistem Informasi Geografis merupakan 

sekumpulan prosedur secara manual maupun berbasis komputer yang digunakan untuk 

menyimpan dan menganalisis data bereferensi geografik. 

Dari definisi tersebut maka Sistem Informasi Geografi pada hakekatnya dapat berfungsi sebagai 

: 

• Bank data terpadu, yaitu memadukan data spasial dan non spasial dalam suatu Relational 

Database Management System. 

• Sistem modeling dan analisa, yaitu sebagai sarana evaluasi potensi wilayah dan 

perencanaan spasial. 

• Sistem pengelolaan yang bereferensi geografis, yaitu untuk mengelola operasional dan 

administrasi yang bereferensi posisi geografi. 

• Sistem pemetaan berkomputer, yaitu sistem yang dapat menyajikan peta sesuai dengan 

kebutuhan. 

Fungsi-fungsi tersebut di atas dapat berjalan karena GIS memiliki kemampuan dalam 

mendeskripsi data geografi, data-data geografi yang dapat dideskripsikan oleh GIS adalah : 

• Data spasial yang berkaitan dengan posisi pada koordinat tertentu. 

• Data non spasial (atribut) yang tidak berkaitan dengan posisi berupa warna, nama, dan 

sebagainya. 

• Hubungan antara data spasial, non spasial dan waktu. 

 

 

Sistem Informasi Geografis menghubungkan data spasial dengan informasi geografis 

mengenai feature tertentu pada peta. Feature yang dimaksud adalah kenampakan obyek dalam 

peta yang berbentuk titik, garis, atau poligon. Informasi ini disimpan sebagai atribut atau 

karakteristik dari feature yang disajikan secara grafis (Team RePPMIT Bakosurtanal, 1991). 

 



 

1.2 Komponen Sistem Informasi Geografis 

Komponen dasar Sistem Informasi Geografik terdiri dari empat macam (Arronoff, 1989) 

:  

• Pemasukan data (Input data).  

Pemasukan data merupakan suatu prosedur pengkodean data ke dalam suatu 

bentuk yang dapat dibaca komputer dan menuliskannya ke dalam basis data Sistem 

Informasi Geografis. Pemasukan data dengan jalan mengubah data dari format analog ke 

format digital. Data yang dimasukkan dalam SIG mempunyai dua tipe data yaitu data 

spasial dan data atribut (data non-spasial). Data spasial menyajikan lokasi geografis suatu 

kenampakan muka bumi (feature). Titik, garis dan luasan dipakai untuk 

menyajikan feature geografis seperti jalan, hutan, persil tanah dan lain-lain. Data atribut 

menyajikan informasi diskriptif seperti nama jalan, komposisi hutan atau nama pemilik 

persil. Adapun cara pemasukaan data yang umum digunakan dalam SIG yaitu 

melalui keyboard, digitasi dengan perangkat digitizer, scanning, koordinat geometri, 

konversi file data digital. 

 

• Manajemen data (Data management).  

Komponen ini berisikan fungsi-fungsi untuk menyimpan dan memanggil kembali 

data. Data-data masukan dalam SIG dikelola sedemikian rupa dalam suatu sistem basis 

data. Basis data didefinisikan sebagai kumpulan data yang saling berhubungan yang 

disimpan bersama dengan sedikit redundansi serta mampu melayani lebih dari satu 

pemakai. Organisasi konseptual dalam suatu basis data disebut dengan model data. Ada 

tiga model data yang dipergunakan dalam mengorganisasi data atribut yaitu : model data 

hirarki, jaringan dan relasional. Sedangkan model data spasial dapat berupa data vektor 

dan data raster.  

 

• Manipulasi dan analisis data (Data manipulation dan analysis).  

Dalam fungsi manipulasi dan analisis ini data diolah sedemikian rupa guna 

memperoleh informasi yang diinginkan dari Sistem Informasi geografis. Manipulasi dan 

analisis dengan membuat algoritma dari data grafis dan atribut yang berupa tumpang-

susun (overlaying) data grafis maupun pengkaitan data grafis dan atribut. 

 

• Penyajian Data (Output data). 

 Penyajian data merupakan prosedur untuk menyajikan informasi dari SIG dalam 

bentuk yang diinginkan pemakai. Output data disajikan 

dalam hardcopy dan softcopy. Output dalam format hardcopy berupa tampilan permanen, 

biasanya dicetak pada kertas, film fotografik atau material lain. Output 

dalam softcopy disajikan melalui layar komputer baik berupa teks atau grafik maupun 

sebagai langkah guna melihat hasil analisis sebelum dicetak secara permanen. 

 

 



 

1.3 Data Sistem Informasi Geografi  

Data dalam SIG merupakan bahan baku yang diproses oleh Sistem Informasi Geografis 

sehingga dihasilkan informasi yang menggambarkan kenampakan permukaan bumi (real world). 

Jenis data geografi dalam SIG terdiri dari :  

• Data spasial, yaitu data grafis yang berkaitan dengan lokasi, posisi dan area pada 

koordinat tertentu. Data spasial mempunyai beberapa hubungan geografi, meliputi : 

o Geometri, yaitu bagaimana masing-masing elemen data dijelaskan pada hubungan 

titik, garis, dan lain-lain serta sistem koordinat yang digunakan. Ada tiga model data 

yang dipergunakan dalam menangani data atribut, yaitu model data hierarki, 

jaringan dan relasional. Sedangkan untuk organisasi data spasial, dalam SIG kita 

mengenal 2 macam model data, yaitu model data raster dan model data vektor. 

o Topologi, yaitu hubungan satu elemen terhadap elemen yang lain. 

o Kartografi, yaitu bagaimana elemen peta ditampilkan pada monitor atau plotter 

disajikan secara kartografi. 

• Data non spasial (atribut), menguraikan karakteristik objek-objek geografi dari spasialnya 

seperti warna, tekstur dan keterangan lainnya. 

• Hubungan antara data spasial, non spasial dan waktu. 

 

1.4 Klasifikasi Feature Peta 

Dalam Sistem Informasi Geografi, peta merupakan penyajian data informasi secara grafis 

dari kenampakan (feature) permukaan bumi. Data atau informasi dari kenampakan permukaan 

bumi ditampilkan dalam feature peta. Berdasarkan kenampakan karakteristik, feature peta 

dikelompokan menjadi 3 : 

• Feature titik, yaitu kenampakan geografis permukaan bumi berupa titik yang dibentuk dari 

sepasang koordinat yang mempunyai suatu identifier yang menghubungkan ke suatu 

tabel atribut feature. Contoh feature titik pada peta skala kecil adalah letak kota yang 

direpresentasikan dengan titik. Isi dari tabel atribut feature titik ini adalah keterangan 

nama kota, jumlah penduduk dan sebagainya. 

• Feature garis, yaitu kenampakan geografis permukaan bumi berupa garis yang terbentuk 

dari serangkaian koordinat yang mempunyai identifier yang menghubungkan ke 

tabel atribute feature garis. Contohnya adalah feature jalan dan sungai dimana 

tabel atribut feature-nya berisi nama jalan, panjang jalan, nama sungai, panjang sungai 

dan sebagainya. 

• Feature luas, yaitu kenampakan geografis permukaan bumi berupa luasan yang terbentuk 

dari beberapa rangkaian koordinat dimana koordinat awal dan koordinat akhirnya sama 

serta mempunyai identifier di dalamnya yang menghubungkan tabel atribut 

feature luasan. Contohnya adalah batas administrasi kabupaten, kecamatan, desa dan 

sebagainya. Isi tabel atributnya adalah luas wilayah, keliling, nama batas administrasi dan 

sebagainya. 



 

 

 

BAB 2  

TAHAPAN PELAKSANAAN 

 

2.1. Materi Pembelajaran 

Berikut Materi pembelajaran yang akan dipraktekkan : 

• Input data dan mengolah data raster ( Data Elevation Model) 

Digital Elevation Model (DEM) adalah model digital yang memberikan informasi bentuk 

permukaan (topografi) dalam bentuk data raster, vektor atau bentuk data lainnya. DEM memuat 

informasi ketinggian dan kemiringan yang mempermudah interpretasi. sehingga dapat 

digunakan dalam berbagai aspek kehidupan. Dalam bidang kebencanaan DEM dapat digunakan 

untuk membuat peta rawan bencana banjir atau tanah longsor. Dalam bidang manajemen 

sumberdaya DEM dapat digunakan untuk mendapatkan lokasi penambangan. Dan masih banyak 

kegunaan lainnya dari DEM.  

• Analisis  Arah Kemiringan Lereng 

 

• Seni Pemetaan Membuat Hillshade (Relief) pada Arcgis 

 

 

• Jenis-jenis Overlay 

 

• SCORING 

 

 

 

 

 

 

 

 

 

 



 

 
2.2.Input data dan mengolah data raster ( Data Elevation Model) 

 

1. Input Data Elevation Model (DEM) berupa file .tif dan File SHP yang sudah disimpan 

dalam folder. Pada pelatihan ini wilayah yang menjadi bahan pelatihan adalah 

Kabupaten Purwakarta. 

 

 

 



 

2. Langkah  selanjutnya  adalah  memotong  data DEM  menjadi  bentuk  sesuai  dengan 

wilayah yang di kerjakan dengan cara mengklik pada ARCtoolbox kemudian pilih 

Spatial Analyst Tools > Extraction > Extract by mask. Pada kolom Input raster 

Masukan data file .tif dan juga pada kolom Input raster or feature mask masukan data 

SHP Administrasi_Desa_AR_25K. Kemudian pada kolom output raster pilih lokasi 

penyimpanan dan beri nama file extract_tif kemudian klik OK. 

 

 

 

 



 

3.         Langkah selanjutnya Klik pada ARCToolbox kemudian pilih Data management tools 

> Projections and Transformation > Project. Masukan data SHP 

Administrasi_Desa_AR_25K pada kolom Input dataset or feature Class. Kemudian pilih 

lokasi save file pada Output Dataset or Feature Class dan beri nama 

Administrasi_Desa_AR_25K_Proj. Pada Kolom Output Koordinate System pilih 

sistem koordinat Projected Coordinate System > UTM > WGS 1984 > Southern 

Hemisphere > WGS 1984 UTM Zone 48S (hal ini dikarenakan wilayah Kabupaten 

Purwakarta dalam sistem Koordinat UTM berada dalam zona 48S) kemudian klik OK. 

 

 

 

4.         Langkah selanjutnya Klik pada ARCToolbox kemudian pilih Data management tools 

> Projections and Transformation > Raster > Project Raster. Masukan data Extract.tif 

pada kolom Input Raster. Kemudian pilih lokasi save file pada kolom output raster 

dataset dan beri nama Extract.tif_Projectraster . Pada Kolom Output Koordinate 

System pilih sistem koordinat Projected Coordinate System > UTM > WGS 1984 > 

Southern Hemisphere > WGS 1984 UTM Zone 48S. Kemudian Klik Ok. 

 



5. Langkah selanjutnya Klik pada ARCToolbox kemudian pilih Spatial Analyst Tools > 
 

 

 

Surface > Slope. Masukan file Extract.tif_Projectraster pada kolom Input raster. 

Kemudian pilih lokasi save file pada kolom Output Raster dan beri nama 

Slope_Extract. Pada kolom Output measurement ubah menjadi PERCENT_RISE. 

Kemudian Klik Ok. Pada tool slope ini berfungsi untuk menampilkan garis kontur 

wilayah pada peta. 

 

 
 

 



 

 

6. Pada Table Of Content (sebelah kiri layar) terdapat beberapa layer. Klik kanan > 

Properties pada file Slope_Extract. Untuk merubah warna peta untuk membedakan 

tinggi atau rendahnya permukaan tanah klik pada Symbology > Classified. Ubah warna 

yang dinginkan pada kolom Color Ramp. Kemdian pada kolom Classes ubah menjadi 

angka 5. Setelah itu Klik pada kolom Classify, pada kolom Break Values Klik % 

kemudian rubah angka pada kolom menjadi 8 – 15 – 25 – 45 -100 Kemudian klik Ok. 

 

 

 

 



 

 

 

Zonal > Zonal Statistics as Table. Pada kolom Input Raster or Feature Zone 

Data masukan file Administrasi_Desa_AR_25K_Proj kemudian pada kolom 

Zona Field pilin WADMKC hal ini dikarenakan pada atribut tabel pada data shp 

administrasi Kabupaten   Purwakarta   terdapat   tabel   nama   kelurahan/desa   

pada   judul    tabel WADMKC. Kemudian pilih lokasi save file pada kolom output 

table dan beri nama ADMINISTBL setelah itu klik Ok. 

 

 

 

 

8. Langkah selanjutnya membuka atribut tabel pada file ADMINISTBLdengan cara 

klik kanan > open. Pada tabel ini dapat terlihat tinggi -  rendahnya permukaan 

tanah pada desa di Kabupaten Purwakarta dengan melihat kolom MIN dan MAX 

 

 

 

2.3.Analisis  Arah Kemiringan Lereng 

Analisis topografi dilakukan untuk memberikan pemahaman umum mengenai 

areal, bidang lahan dan variasi permukaan lahan (terrain). Oleh karena itu, obyek yang 



 

 

dianalisis adalah data permukaan (surface) dalam bentuk raster, TIN, LAS ataupun terrain. 

Beberapa analisis yang sering dilakukan adalah elevasi, slope, aspect, kontur, steepest path, 

curvature, dan hillshade. Untuk kesempatan ini kita hanya akan membahas analisis berupa 

"aspect" sementara untuk analisis lain akan dibuat pada tutorial terpisah sehingga teman-

teman lebih mudah untuk memahaminya. 

Aspect adalah arah (azimuth) kelerengan dari setiap sel. Aspect dapat juga dianggap 

sebagai arah slope menurun dari suatu sel. Nilai aspect sangat bermanfaat untuk 

merepresentasikan arah relatif lereng terhadap arah datang cahaya matahari. Lereng yang 

menghadap ke timur mendapat sinar matahari pagi lebih banyak daripada arah lereng yang 

menghadap ke barat, lereng yang menghadap ke utara, mendapat cahaya matahari lebih 

banyak pada musim kemarau dibandingkan dengan lereng yang menghadap ke selatan, dan 

sebagainya. 

Sebagai salah satu data pendukung dalam berbagai analisis tentu banyak fungsi dan 

pengaplikasian dari peta arah kelerengan atau bisa kita sebut peta Aspek, diantaranya: 

1. Konservasi Lahan / Pengelolaan Lahan 

2. Identifikasi daerah rawan longsor 

3. Penilaian Potensi Erosi 

4. Arah mengalirnya air 

5. Pengaruh kecepatan pelapukan batuan menjadi tanah 

Pada tutorial ini, mimin hanya akan menjelaskan untuk membuat peta aspek saja tanpa 

menerapkan studi kasus didalamnya. Karena akan sangat panjang jadinya jika 

digabung. Untuk menurunkan data Aspect dari data DEM dapat dilakukan dengan langkah 

berikut. 

1. Dengan ArcMap, buka project 

2. Jalankan tool Aspect yang terdapat di dalam ArcToolbox 

3. Tentukan input data raster, yaitu skusandem.tif 

4. Tentukan folder dan file raster output 

5. Klik OK untuk menjalankan tool 

 
Gambar Menjalankan tool Aspect 
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Output raster adalah data aspect yang merupakan data kontinyu dengan rentang data 0 - 

360 derajat yang menunjukkan arah lereng: 

Flat = Datar (-1) 

North = Utara (0-22.5) 

Northeast = Timur Laut (22.5-67.5) 

East = Timur (67.5-112.5) 

Southeast = Tenggara (112.5-157.5) 

South = Selatan(157.5-202.5) 

Southwest = Barat Daya (202.5-247.5) 

West = Barat 247.5-292.5) 

Northwest = Barat Laut (292.5-337.5) 

North = Utara (337.5-360) 

Langkah lanjutan untuk menjadikan data hasil output ini sebagai parameter untuk 

analisis lanjut adalah raster to polygon, seleksi berdasarkan query, dan lakukan 

klasifikasi. tahap-tahapnya tidak akan jauh-jauh dari yang mimin sebutkan ini. 

 
Gambar Data aspect 
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2.4.Seni Pemetaan Membuat Hillshade (Relief) pada Arcgis 

Dalam dunia pemetaan tidak hanya berkutat tentang analisis data tapi kita juga 

berbicara tentang seni. Percuma saja analisa yang kita lakukan sangat akurat tapi dalam 

penyampaian informasinya kepada orang lain sangat buruk, seperti tampilan yang begitu 

membosankan sehingga orang lain melihatnya menjadi biasa saja. Dengan adanya seni 

dalam peta biasa akan menjadi lebih bernilai, maka dari itu seni dalam penyajian peta itu 

sangat penting sekali. 

 

Salah satu cara untuk memperindah peta yang akan kita buat adalah dengan 

menggunakan teknik Hillshade sehingga bentuk dataran (daratan) yang akan menjadi 

lebih natural (3D) karena memperlihatkan tinggi rendah permukaannya (Relief). 

 

Pada kesempatan ini mimin akan memberikan tutorial atau bisa dibilang tips dan trik 

karena pada umumnya caranya mungkin teman-teman Lapak GIS sudah pada tahu tapi ada 

sedikit penambahan opsi lagi. 

 

Pada umumnya ketika melakukan hillshade kita tinggal menggunakan alat yang ada di 

Arctoolbox, otomatis langsung jadi. Tapi ada juga hillshade yang bisa kita pakai tanpa 

menggunakan tools, hasilnya juga terlihat bagus. Kendati demikian penasaran bukan 

mana yang lebih bagus...? Hillshade dengan tools, tanpa tools atau gabungan keduanya 

dalam hal seni pemetaan!!! Mari kita coba praktekan. 

1. Silahkan siapkan dulu bahannya (bawah artikel), lalu buka di Arcgis. 

2. Lakukan hillshade tanpa mengggunakan tool pada data DEM, caranya klik kanan 

pada layer DEM pilih properties 

3. Klik tab Simbology 

4. Klik Classified, pada classes pilih angka satu (1) dan ubah warna ke 30% grey. 

Jangan lupa di centang "use hillshade effect" 

5. Klik OK. 

 
 

 

  Sekarang kita buat lagi hillshade dengan arctoolbox, caranya cukup mudah. 

  Tinggal menujur Arctoolbox → Spatial analyst Tools → Surface → Hillshade. 

  Masukkan data input dan Klik OK. 
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Bahan seni pemetaan dengan teknik hillshade sudah siap, sekarang kita bereksperimen 

dengan mensimulasikan Area Of Intereset (AOI) yang kita punya: 

1. AOI hillshade with tools + Area diluar AOI hillshade with tools 

2. AOI hillshade without tools + Area diluar AOI hillshade with tools 

3. AOI hillshade with tools + Area diluar AOI hillshade without tools 

4. AOI hillshade without tools + Area diluar AOI hillshade without tools 

 

2.5.Analisis Overlay Peta pada ArcGIS 

Overlay Peta dapat dilakukan dengan berbagai macam cara salah satunya dengan 
menggukan software GIS yang memang memilki kemampuan untuk hal tersebut. 
Pada pembahasan kita kali ini akan menggunakan ArcGIS dengan Full Tools 
Overlaynya. 

Toolset overlay pada terdiri dari beberapa tool yang dapat digunakan untuk 
melakukan operasi tumpang susun. Di dalam toolset overlay terdapat tool erase, 
identity, intersect, dan spatial join, symmetrical difference, union, dan update seperti 
tampak pada Gambar berikut. 

 

Gambar Toolset Overlay dan tool-tool di dalamnya 
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Bahasan mengenai tool-tool yang terdapat di dalam toolset overlay diatas akan mimin 
uraikan secara padat dan tepat serta mudah dipahami, silahkan dibaca sampai habis 
ya. 

Erase - Overlay Analysis Tools 

Tool erase digunakan untuk menghapus bagian fitur yang overlap dengan fitur erase 
(polygon). Fitur yang tidak overlap dengan fitur erase akan disimpan sebagai fitur baru 
seperti diilustrasikan pada Gambar dibawah. Dapat terlihat bahwa fitur polygon1 
adalah fitur input yang akan di-erase oleh fitur polygon2. 

 

 

 

Gambar Ilustrasi penggunaan tool erase 

 

Identity - Overlay Analysis Tools 

Tool identity digunakan untuk menentukan overlap antara fitur input dan fitur identity. 
Keseluruhan bagian dari fitur input dan bagian overlap antara fitur input dengan fitur 
identity akan menjadi file baru. Tool identity memiliki sedikit kesamaan dengan tool 
intersect. Perbedaannya adalah jika tool identity tetap menjaga keseluruha bagian 
dari fitur input, sedangkan tool intersect hanya. menjaga bagian fitur yang overlap 
saja. Atribut dari fitur identity akan ditransfer pada bagian yang overlap seperti 
diilustrasikan pada Gambar berikut. 
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Gambar Ilustrasi penggunaan tool identity 

 

Intersect - Overlay Analysis Tools 

Tool intersect digunakan untuk menentukan overlap antar fitur-fitur input. Bagian yang 
overlap antar fitur input akan dijadikan file fitur baru seperti diilustrasikan pada 
Gambar berikut. 
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Gambar Ilustrasi penggunaan tool intersect 

 

Spatial join - Overlay Analysis Tools 

Tool spatial join digunakan untuk. menggabungkan dua tabel dengan menggunakan 
korelasi spasial di antara fitur dari masing-masing tabel. Spatial join dapat dilakukan 
meskipun tidak terdapat field kunci pada masing-masing tabel karena yang digunakan 
adalah korelasi spasial. Bahasan mengenai spatial join disajikan pada halaman ini. 

 

Symmetrical difference - Overlay Analysis Tools 

Tool symmetrical difference digunakan untuk membuat fitur kelas baru dari dua fitur 
polygon yang saling overlap. Hanya fitur yang tidak overlap. yang akan dijadikan fitur 
baru seperti diilustrasikan pada Gambar berikut. 
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Gambar Ilustrasi penggunaan tool symmetrical difference 

 

Union - Overlay Analysis Tools 

Tool union digunakan untuk menggabungkan dua atau lebih fitur polygon. Seluruh 
fitur dan data atributnya digunakan pada fitur baru, baik itu pada bagian yang overlap 
maupun yang tidak seperti diilustrasikan pada Gambar berikut. 

 

 

 

Gambar Ilustrasi penggunaan tool union 
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Update - Overlay Analysis Tools 

Tool update digunakan untuk menghitung bagian yang overlap antara fitur input dan 
fitur update. Data atribut dan geometri fitur input-diganti oleh atribut dan geometri 
fitur update seperti diilustrasikan pada Gambar berikut. 

 

 

 

Gambar Ilustrasi penggunaan tool update 
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2.6.Analisis Skoring 

 

1.   Buka arcmap 

 

 

2.   Masukkan inputa data 

 

3.   Tampilan akan seperti ini 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

4.   Klik pada layer Curah_Hujan  Open Atributte table 

 

 

 

5.   Muncul tampilan table  klik ikon table options pada pojok kiri atas 

windows 

 

 

 

 

6.   Table Options  add field 

 

 

 

 

 

 

 

 



 

 

7.   Buat kolom baru untuk Skoring dari data curah hujan. Name : 

SkorCH 

 

 Type : Short Integer  OK 

 

 

8.   Klik Editor  Start Editing 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

9.   Tuliskan  skor  sesuai  dengan  teori  dan  nilai  yang  dinginkan.  Dalam praktikum  

ini,  semakin  tinggi  curah  hujan,  maka   semakin  tinggi skornya. 

 

 

10. Save Edit  Stop Editing 

 

 

 

 



 

 

 

 

 

 

 

 

11. Menambanhkan  table  skor  untuk  kelerengan.  Klik  

kanan  pada  layer peta_kemiringan  open attribute table   

 

table options  add field  

12. Tuliskan  skor  sesuai  dengan  teori  dan  nilai  yang  dinginkan.  Dalam 

praktikum   ini,   semakin   tinggi   Kelerengan,   maka   semakin   tinggi 

skornya. 

 

 

 

 



 

 

13. Menambanhkan  table  skor  untuk  ketinggian.  Klik  kanan  pada  layer 

peta_kemiringan   open attribute table  table options  add field 

 Tuliskan skor sesuai dengan teori dan nilai yang dinginkan. Dalam 

praktikum   ini,   semakin   tinggi   Kelerengan,   maka   semakin   tinggi 

skornya 

 

 

 

14. Menambanhkan table skor untuk Penggunaan Lahan. Klik kanan pada 

layer peta_kemiringan   open attribute table  table options  add field  

Tuliskan  skor sesuai dengan teori dan nilai yang  dinginkan. Dalam 

praktikum ini, skor disesuaikan dengan jenis penggunaan lahan yang 

datanya berasal dari data sekunder 



 

 

 

 

 

15. Menambanhkan table skor untuk Tekstur Tanah. Klik kanan pada 

layer peta_kemiringan   open attribute table  table options  add field 

 Tuliskan skor sesuai dengan teori dan nilai yang dinginkan. Dalam 

praktikum ini, semakion halus tekstur tanah, semakin tinggi skornya 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

16. Memulai Overlay. Geoprocessing  Intersect 



 

 

 

 

 

 

17. Input  fetures : masukkan  semua  peta yang akan di Overlay    pilih 

folder untuk menyimpan  OK 

 

 

 

 

 

 

 

 

 

18. Beri nama : Inter_banjir  Save 

 



 

 

 

 

 

 

19. OK 

 

 
 

 

 

 

 

 

 

 

20. Hasilnya akan menjadi sperti ini 

 



 

 

 

 

 

21. Mulai pembobotan. Klik kanan pada inter_banjir  properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

22. Tampil atbel seperti berikut 

 



 

 

 

 

23. Table options  add field 

 

 
 

 

 

24. Pertama  add  field  untuk  menambahkan   kolom  Skor  bobot  

Curah 

 

Hujan. Name :  SkorBbtCH  Type Float  OK 

 



 

 

 

 

25. Kedua add filed unutk menambhakan  skor bobot kemiringan. 

Name : SkorBbtLER  Type Float  OK 

 

 

26. Ketiga add filed unutk menambhakan  skor bobot ketinggian.  Name 

: SkorBbtTng Type Float  OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

27. Keempat add filed unutk menambhakan skor bobot penggunaan 

lahan. 

 

Name :  SkorBbtPL  Type Float  OK 

 

 
 

 

28. Kelima add filed unutk menambhakan skor bobot tekstur tanah. 

Name 

 

: SkorBbtTek  Type Float  OK 

 

 

 

 

 

 

 

 



 

 

29. Isi pembobotan. Klik kanan pada kolom paling atas  Field Calculator 

 

 

30. OK 

 

 

 

31. Pada fields pilih SkorCH 

 



 

 

 

 

 

32. Kemudian  kalikan  Fields  yang  dipilih  dengan  pengali  yang  sesuai 

dengan data sekunder.  Dari data sekunder yang di dapat,  porsi curah 

hujan dalam mempengaruhi  banjir adalah sebanyak 30%, maka scorch 

tersebut dikalikan 0,3 

 

 

 

 

33. Pembobotan  untuk kemiringan.  Pertama  hapus dulu data yang  sudah 

ada dengan klik tombol clear



 

 

 

 

 

34. Untuk kemiringan.  Fields : SkorLER   Dari data sekunder  yang  di 

dapat, porsi kemiringan dalam mempengaruhi  banjir adalah sebanyak 

20%, maka scorch tersebut dikalikan 0,2 

 

 

 

 

 

35. Untuk Penggunaan Lahan. Fields : SkorPL  Dari data sekunder yang 

di dapat, porsi penggunaan lahan dalam mempengaruhi  banjir adalah 

sebanyak 20%, maka scorch tersebut dikalikan 0,2



 

 

 

 

 

36. Untuk Tekstur. Fields : SkorTEK  Dari data sekunder yang di dapat, 

porsi tekstur tanah dalam mempengaruhi  banjir adalah sebanyak 20%, 

maka scorch tersebut dikalikan 0,2 

 

 

 

37. Untuk  Ketinggian.  Fields : SkorLER   Dari data  sekunder  yang  di 

dapat, porsi ketinggian  dalam mempengaruhi  banjir adalah  sebanyak 

10%, maka scorch tersebut dikalikan 0,



 

 

 

38. Setelah  proses  selesai,  kolom  yang  semula  kosong  kini  berisi  nilai yang 

sudah sesuai dengan bobotnya. 

 

 

 

 

39. Tambahkan lagi sebuah kolom. 

 

 

 

 

 



 

 

 

 

 

 

40. Beri nama kolom tersebut : SKORTOTAL   type : long integer   

 

OK 

 
 

41. Klik  kanan  pada  baris  teratas  pada  kolom  SKORTOTAL    field 

calculator 

 

 

42. Tambahkan semua kolom hasil pembobotan. 

 

 



 

 

 
 

 

 

43. Hasilnya akan seperti ini 

 

 

 

44. Atau  seperti ini 

 



 

 

 
 

 

 

 

 

 

 

 

45. Add filed lagi untuk keterangan tingkat kerawanan 

 



 

 

 

 

 

 

46. Name : KELASRAWAN   type  text 

 

 

 

 

 

 

 

 

 



 

 

 

47. Menambahkan       keterangan      tingkat      kerawanan      berdasarkan 

 

SKORTOTAL  select by attribute  klik dobel SKORTOTAL 

 

 

 

 

 

48. Klik get unique values 

 

 

 



 

 

 

 

 

49. Hasilnya akan seperti ini 

 

 

 

 

 

50. Kita akan memberikan keterngan pad nilai 7. Klik dobel pada tanda = 

 

dan angka 7 dari getunique value 

 

 



 

 

 

 

 

 

51.  Apply 

 

 

 



 

 

 

 

52. Baris dimana  yang  pada kolom  SKORTOTAL  secara  otomatsi  akan 

diblok (berwarna biru) 

 

 

 

 

 

 

53. Beri keterangan. Jika nilai 7 dan 6, maka keterangannya adalah Sangat Rawan 

Banjir. Jika skor 5 dan 4, maka keterangannya Rawan Banjir. Jika skor 3 

dan 2. Maka keterangannya Kurang Rawan Banjir. 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

54. Hasilnya akan seperti ini 

 

 

 
 

 

 

55. Ulangi langkah pemberian keterangan tersebut pada nilai 6, 5, 4, 3, dan 

 

2 

 



 

 

 

 

 

 
 



 

 

 

 

 

 

 



 

 

 

 

 

 
 



 

 

 
 



 

 

 

 

 

 
 

 

 

56. Hasilnya akan menjadi seperti ini 

 



 

 

 

 

 

 

 

 



 

 

 

 

 

 

57. Cek hasil dengan klik kanan pada inter_banjir  properties 

 

 

 

 

58. Symbology     Categories   :   Unique   Values      Value   field    

 

KELASRAWAN  add all values  apply  OK 

 



 

 

 

 

 

 

59. Hasilnya akan menjadi seperti ini 

 

 

 

 

 



 

 

60. Peta yang diuhasilkan  masih terlalu  ruwet  dengan  banyaiknya  garis- garis.  

Maka  dari itu perlu  disederhanakan   klik  geoprocessing   dissolve 

 

 

 

 

 

 

 

61. Input Features : inter_banjir  centang  apa yang mau disederhanakan. 

 

Dalam praktikum  ini, yang mau disedrhanakan  adalah  polygon  hasil 

keterangan KELASRAWAN 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

62. Pilih tempat menyimpan 

 

 

 

 

 

 

 

63. Maka hasilnya akan seperti ini 

 

 

 

 



 

 

 

64. Ganti  warna.  Klik  kanan  pada  hasil  dissolve  tadi    properties   symbology  

Categories  unique values  add values  Apply  OK 

 
 

65. Hasilnya akan menjadi seperti ini 

 

 


